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GUI Information and Shortcuts

This appendix describes the Cisco TransportPlanner views, menus, tools, and shortcuts options.
more information about Cisco TransportPlanner, refer toChapter 1, “Overview.”

Manage the Cisco TransportPlanner Window
The Cisco TransportPlanner window provides a menu bar, toolbar, a Project Explorer pane, a Prop
pane, an Analyzer pane, and a Task Pane to allow you to manage a network design (Figure A-1). The
Networks Mgmt Tree tab displays the networks that you have created for a project. The NtVw Net#
displays the sites for a network (identified by the Net# on the tab).

Figure A-1 Cisco TransportPlanner Window with Network Tree
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Menu and Toolbar Options
The Cisco TransportPlanner window menu bar and toolbar provide primary Cisco TransportPlann
functions.Table A-1 shows the actions that are available from the menu and toolbar.

Table A-1 Menu and Toolbar Options

Menu Menu Option Toolbar Description

File New Creates a new Cisco TransportPlanner project. See the“2.3 Creating a Project”
section on page 2-36.

Open Opens an existing Cisco TransportPlanner project. See the“2.1.1 Opening a
Project” section on page 2-15.

Close Closes the current project without closing the Cisco TransportPlanner session
you have not saved the current project, Cisco TransportPlanner will prompt yo
to save before closing. See the“2.1.5 Closing a Project” section on page 2-18.

Save Saves the current project. See the“2.1.3 Saving a Project” section on page 2-16.

Save As Allows you to save the current project with a new file name. See the
“2.1.3 Saving a Project” section on page 2-16.

Import 2.5
Project

— Allows you to import a Cisco TransportPlanner Release 2.5 project into
Cisco TransportPlanner Release 7.0.1. See the“2.1.4 Importing a Cisco
TransportPlanner Release 2.5 Project” section on page 2-16.

Clear History — Clears the file history from Cisco TransportPlanner. Cisco TransportPlanner
maintains a list of the last ten open projects in the File menu.

Exit — Exits the Cisco TransportPlanner software.
A-2
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



Appendix A      GUI Information and Shortcuts
Manage the Cisco TransportPlanner Window

s

r
r.

e

d

or

ult

e

ts

,

,

View My Default
Layout

— Changes the Cisco TransportPlanner display to the user default layout.
Cisco TransportPlanner allows you to define the default value for Platform
Options, Project Options, and General Options. The defined value are used a
default for each new created project. See the“2.2 Setting
Cisco TransportPlanner Options” section on page 2-18.

Default Layout — Returns the Cisco TransportPlanner display to the system default layout.

Tasks Pane — Displays the commands available for the selected entity (network, site, duct,
etc.).

Project
Explorer

— Displays the Project Explorer pane, which includes folders for project notes,
networks, sites, fibers, traffic demand groups, subnets, maintenance centers,
restricted equipment list, and reports. Clicking the plus (+) sign by each folde
expands the folder. Clicking the minus (–) sign by each folder hides the folde
contents. You can also right-click a folder and chooseExpand from the shortcut
menu to show folder contents. The default location of the Project Explorer pan
is the upper left section of the Cisco TransportPlanner window.

Properties — Displays the Properties pane, which shows parameter settings for the selecte
entity in the Project Explorer, Networks Mgmt Tree tab, or NtVw Net# tab. The
default location of the Properties pane is the lower left section of the
Cisco TransportPlanner window.

Analyzer
Messages

— Displays the Analyzer Messages pane at the bottom of the
Cisco TransportPlanner window. The Analyzer Messages pane displays any err
messages that occur during network analysis.

Tools Options — Opens the Options Explorer dialog box, where you can change the user defa
settings. See the“2.2 Setting Cisco TransportPlanner Options” section on
page 2-18.

DB Parts Mgmt — Opens the PartsTreePanel dialog box, where you can view the list of availabl
parts for each release. See the“2.2.3 Setting the Default Project Values” section
on page 2-24.

Price List Mgmt — Opens the Price Manager dialog box, where you can view maintenance contrac
and add price databases. See the“2.9 Managing the Price List” section on
page 2-136.

Plug In — Opens the PlugIn Registry dialog box, which allows you to customize
Cisco TransportPlanner with plug-ins released by Cisco. See the“2.2.8 Adding
Plug-ins” section on page 2-33 and the“2.2.9 Managing Plug-ins” section on
page 2-34.

Export — Opens the Export dialog box, which allows you to export user options, price lists
maintenance contracts, and parts database files. See the“2.2.5 Exporting a File”
section on page 2-30.

Import — Opens the Import dialog box, which allows you to import user options, price lists
maintenance contracts, and parts database files. See the“2.2.6 Importing a File”
section on page 2-31.

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Script Run Script — Opens the Choose a script to run dialog box, which allows you to run a script th
Cisco provides. See the“2.2.11 Running a Script” section on page 2-35.

Run Again — Runs the script that was last used.

Common — Displays any scripts in the scripts directory where Cisco TransportPlanner is
installed.

User — Displays any scripts in the C:/Documents And
Settings/<user-home>/MP_<version>/scripts directory.

Refresh Dirs — Refreshes the Script menu. This command removes script names from the R
Again menu, and updates the Script > Common and User menus. See the
“2.2.12 Refreshing the Script Menu” section on page 2-35.

Help Manual — Opens the Cisco TransportPlanner online help.

Tips Of The
Day

— Opens the Tip of the Day dialog box, which provides helpful hints about using
Cisco TransportPlanner. Click theNext button to view the next tip and theBack
button to view a previous tip. CheckShow Tips on Startupto display the Tip of
the Day dialog box when you launch Cisco TransportPlanner.

About — Displays Cisco TransportPlanner version information.

— Create a new
site

Opens the Site Creation wizard when you click this icon and then click in the
Cisco TransportPlanner window. See the“2.3.1 Adding Sites” section on
page 2-45.

— Create a new
duct

Allows you to create a new duct between sites. See the“2.3.2 Adding Fiber
Spans” section on page 2-46.

— Create a new
P2P demand

Opens the Point to Point Demand Creation Wizard when you click this icon an
then click two sites. See the“2.3.4 Creating a Point-to-Point Demand” section
on page 2-48.

— Create a new
P-ring demand

Opens the P-Ring Creation Wizard. See the“2.3.5 Creating a Protected Ring
Demand” section on page 2-50.

— Create a new
TDM
Aggregated
demand

Opens a TDM creation wizard. See the2.3.8 Creating TDM Aggregated
Demand, page 2-57

— Create a new
Ethernet
Aggregated
demand

Opens a Ethernet creation wizard. See the2.3.7 Creating Ethernet Aggregated
Demand, page 2-55

— Zoom in Zooms in on the NtVw Net# tab.

— Zoom out Zoom out from the NtVw Net# tab.

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Cisco TransportPlanner Panes
Cisco TransportPlanner provides four panes that help you manage a network design: Project Ex
Properties, Analysis, and Tasks Pane.

— Normal viewing Returns the NtVw Net# tab to normal viewing (1:1).

— Fit to window Resizes the view so that all sites fit inside the NtVw Net# tab window.

— Save network
view image

Saves a JPEG of the network design. See the“2.7.5 Creating a JPEG of the
Network Design” section on page 2-130.

— Analyze
Network

Analyzes the selected network. See the“2.4 Analyzing the Network” section on
page 2-62.

— Enter design
mode

Puts the selected Design-Analyzed network back into the design mode for furth
changes. See the“2.4 Analyzing the Network” section on page 2-62.

— Put current
network in
upgrade mode

Creates a copy of the selected Design-Analyzed network in the Upgrade stat
See the“2.7.3 Creating an Upgrade Network” section on page 2-128.

— Delete current
network

Deletes the selected network. See the“2.6.12 Deleting a Network” section on
page 2-112.

— Copy current
network

Copies the selected network. See the“2.7.1 Creating a Copy of the Network”
section on page 2-127.

— Put current
network in
install mode

Creates a copy of the selected Design-Analyzed network in the Install state. S
the“2.7.2 Creating a Network in the Install State” section on page 2-127.

— Reports Diff Opens the Reports Diff dialog box, which allows you to create a report that show
the differences between networks.

— Run the
Garbage
Collector

Deletes unloaded networks from memory.

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Project Explorer Pane

The Project Explorer pane provides a management tree for the entire project. Each network app
a folder that contains the sites, fibers, traffic groups, subnets, maintenance centers, restricted equ
lists, and reports for that network. If you have made changes to a network design, that network f
and the changed item folder appear in blue italics in the pane.

By default, the Project Explorer pane is located in the upper left section of the Cisco TransportPla
window. Table A-2 shows the actions that are available from the Project Explorer toolbar.

Properties Pane

The Properties pane shows all of the parameters set for a selected item (either in the Project Ex
the Network Mgmt Tree tab, or the NtVw Net# tab). Many items are editable in the Properties pane
default, the Properties pane is located in the lower left section of the Cisco TransportPlanner win

Table A-2 Project Explorer Toolbar Options

Toolbar Description

Displays the Project Explorer as a single pane.

Displays the Project Explorer as split panes. The upper pane contains the main project tr
the lower pane shows only the folders for the network that is selected in the upper pan

Auto scrolls to the selected object in the Project Explorer tree. For example, if you clic
on a site in the NtView Net# tab but it is not in view in the Project Explorer tree,
Cisco TransportPlanner will automatically scroll the Project Explorer pane until the
selected site is in view.

Moves backward through the list of previously selected items in the Project Explorer.

Moves forward through the list of previously selected items in the Project Explorer.

Moves (undocks) the Project Explorer pane from the default location in the upper left
corner so that you can move it around your desktop area as an individual window.

Moves the Project Explorer back to the default location.

Hides the Project Explorer. To view again, move the mouse over the Prop tab that appe
in the upper left corner of the Cisco TransportPlanner window.

When in hidden mode, reopens the Project Explorer in the default location.

Closes the Project Explorer pane. To reopen, chooseProject Explorer from the View
menu.
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Table A-3 shows the actions that are available from the Properties Pane toolbar.

Analyzer Pane

The Analyzer tab at the bottom of the Cisco TransportPlanner window appears after you have ana
a network design. Clicking the Analyzer tab opens the Analyzer pane.Table A-5shows the actions that
are available from the Analyzer pane.

Table A-3 Properties Pane Toolbar Options

Toolbar Description

Categorizes the properties by type.

Organizes the properties in alphabetical order.

Shows or hides the description area at the bottom of the Properties pane.

Expands the property categories (if collapsed).

Collapses the property categories (if expanded).

Moves (undocks) the Properties pane from the default location in the lower left corner
that you can move it around your desktop area as an individual window.

Moves the Properties pane back to the default location.

Hides the Property pane. To view again, move the mouse over the Prop tab that appea
the upper left corner of the Cisco TransportPlanner window.

When in hidden mode, reopens the Properties pane so that it appears in the default loca

Closes the Properties Pane. To reopen, chooseProperties from the View menu.
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Tasks Pane

The Tasks Pane lists the available commands and reports for a selected item. The commands ch
based on the selected item. For example, a selected site will have different commands available
selected fiber span. By default, the Tasks Pane is located in the upper right section of the
Cisco TransportPlanner window.Table A-5 shows the actions that are available from the Tasks Pan
toolbar.

Table A-4 Analyzer Toolbar Options

Toolbar Description

Moves down through the Analyzer messages.

Moves up through the Analyzer messages.

Opens the Apply Filters dialog box, which allows you to filter the messages to show or hi
Exceptions, Errors, Warnings, and/or Info.

Expands the Analyzer message categories (if collapsed).

Collapses the Analyzer message categories (if expanded).

Moves (undocks) the Analyzer pane from the default location in the lower left corner s
that you can move it around your desktop area as an individual window.

Moves the Analyzer pane back to the default location.

Hides the Analyzer pane. To view again, move the mouse over the Analyzer tab that appe
in the bottom of the Cisco TransportPlanner window.

Opens the Analyzer pane so that it remains open in the bottom section of the
Cisco TransportPlanner window.

Closes the Analyzer pane. To reopen, chooseAnalyzer messages from the View menu.

Table A-5 Tasks Pane Toolbar Options

Toolbar Description

Moves (undocks) the Tasks Pane from the default location in the lower left corner so th
you can move it around your desktop area as an individual window.

Moves the Tasks Pane back to the default location.
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Shortcuts
Cisco TransportPlanner provides the following mouse shortcuts:

• Double-clicking a network icon in the Network Mgmt Tree tab opens the NtVw Net# tab, whic
shows the sites for that network.

• Right-clicking a report table column displays a shortcut menu that allows you to view or hide
columns in a report.

• Right-clicking an item in the Network Mgmt Tree tab or NtVw Net# tabs opens a shortcut menu
allows you to choose actions to perform on the selected item. The shortcut menu options differ b
on the item selected and the network state. (Many commands are not available until a netwo
analyzed.)Table A-6 lists the shortcut menu actions that are available for each item.

Hides the Tasks Pane. To view again, move the mouse over the Tasks tab that appea
the upper right corner of the Cisco TransportPlanner window.

When in hidden mode, reopens the Tasks Pane so that it appears in the default locati

Closes the Tasks Pane. To reopen, chooseTasks Pane from the View menu.

Table A-5 Tasks Pane Toolbar Options (continued)

Toolbar Description
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Table A-6 Shortcut Menu Actions

Item Available Shortcut Actions

Networks in the
following states:
Design, Install, and
Upgrade

• Unload/Load—Unloads or loads the network. See the“2.1.2 Loading and
Unloading Networks” section on page 2-15.

• Edit Note—Allows you to create a note for the network. See the
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Delete—Removes the network from the project. See the“2.6.12 Deleting
a Network” section on page 2-112.

• Copy—Creates a copy of the network. See the“2.7.1 Creating a Copy of
the Network” section on page 2-127.

• Arrange Sites—Allows you to rearrange sites in the
Cisco TransportPlanner window. See the“2.6.22 Arranging Sites” section
on page 2-122.

Analyzed networks • Unload/Load—Unloads or loads the network. See the“2.1.2 Loading and
Unloading Networks” section on page 2-15.

• Edit Note—Allows you to create a note for that item. See the
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Install—Creates a copy of the network in the Install state. See the
“2.7.2 Creating a Network in the Install State” section on page 2-127.

• Delete—Removes the network from the project. See the“2.6.12 Deleting
a Network” section on page 2-112.

• Upgrade—Creates a copy of the network in the Upgrade state. See the
“2.7.3 Creating an Upgrade Network” section on page 2-128.

• Copy—Creates a copy of the network. See the“2.7.1 Creating a Copy of
the Network” section on page 2-127.

• Layout—Opens the Layout tab. See the“2.5.6 Displaying the Layout”
section on page 2-74.

• Internal Connections—Opens the Internal Connections tab. See the
“2.5.4 Viewing Internal Connections” section on page 2-68.

• Optical Results—Opens the Optical Results tab. See the“2.5.9 Viewing
Optical Results” section on page 2-79.

• Wavelength Routing—Opens the Wavelength Routing tab. See the
“2.5.10 Viewing Wavelength Routing” section on page 2-83.

• Bill of Material—Opens the Bill of Materials tab. See the
“2.8.2 Generating a Network BoM” section on page 2-132.

• Installation—Opens a submenu with the following options:

– NE Update—Creates a configuration file for each site in the network
See the“2.5.2 Saving the NE Update File” section on page 2-65.

– Installation Parameters—Opens the Installation Parameters tab. S
the“2.5.3 Viewing the Installation Parameters” section on page 2-66.

• Arrange Sites—Allows you to rearrange sites in the
Cisco TransportPlanner window. See the“2.6.22 Arranging Sites” section
on page 2-122.
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Site Icons
A site icon indicates the functionality of site.Table A-7 lists the site icons.

Sites • Edit Note—Allows you to create a note for that item. See the
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Delete—Removes the site from the project. See the“2.6.14 Deleting
Sites” section on page 2-113.

If the network is analyzed, the following actions are also available:

• Layout—Opens the Layout tab. See the“2.5.6 Displaying the Layout”
section on page 2-74.

• Internal Connections—Opens the Internal Connections tab. See the
“2.5.4 Viewing Internal Connections” section on page 2-68.

• Optical Results—Opens the Optical Results tab. See the“2.5.9 Viewing
Optical Results” section on page 2-79.

• Wavelength Routing—Opens the Wavelength Routing tab. See the
“2.5.10 Viewing Wavelength Routing” section on page 2-83.

• Bill of Material—Opens the Bill of Materials tab. See the
“2.8.2 Generating a Network BoM” section on page 2-132.

• Installation—Opens a submenu with the following options:

– NE Update—Creates a configuration file for each site in the network
See the“2.5.2 Saving the NE Update File” section on page 2-65.

– Installation Parameters—Opens the Installation Parameters tab. S
the“2.5.3 Viewing the Installation Parameters” section on page 2-66.

• Unlock—Unlocks the site. See the“2.7.4 Unlocking Parameters in the
Network Design” section on page 2-129.

Fiber spans • Edit Note—Allows you to create a note for that item. See the
“2.3.9 Adding Notes to a Project” section on page 2-60.

If the network is analyzed, the Unlock command is also available. See the
“2.7.4 Unlocking Parameters in the Network Design” section on page 2-12.

Traffic demands • Edit Note—Allows you to create a note for that item. See the
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Edit—Allows you to edit the demand. See the“2.6.6 Editing a
Point-to-Point Demand” section on page 2-100, “2.6.7 Editing a P-Ring
Demand” section on page 2-101, or “2.6.8 Editing a ROADM Demand”
section on page 2-102.

• Delete—Removes the demand from the project. See the“2.6.15 Deleting
a Traffic Demand” section on page 2-113.

If the network is analyzed, the Unlock command is also available. See the
“2.7.4 Unlocking Parameters in the Network Design” section on page 2-12.

Table A-6 Shortcut Menu Actions (continued)

Item Available Shortcut Actions
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Table A-7 Site Icons

Site Name Site Icon Description

Add/Drop Indicates that this site has add/drop capability. Only
point-to-point and P-ring circuits can be added/dropped at this
site.

Gain equalizer Indicates that this site uses wavelength selective switch cards
control the generated tilt and extend unregenerated distances
The site is realized as an ROADM site without demultiplexer
cards.

Hub Indicates that this site is equipped with filters for adding and
dropping all the channels (on both West and East sides). All
express paths are open in hub configurations.

Line amplifier Indicates that any add/drop traffic is prevented at this site.

OSC site Indicates that site is designated for network communication,
providing the possibility to access the optical service channel
(OSC) for management of the MultiService Transport platform
(MSTP) network. By default, no amplifiers are included in this
site. However, if Cisco TransportPlanner determines that an
amplifier is required in the network, it can automatically place it
at this location. Cisco TransportPlanner allows you to set (force
preamplifier and booster amplifiers for each direction on a OSC
Site node.

Pass Through Indicates that no equipment will be located at this site.

R-OADM Indicates that this site supports Any-to-Any and also Fixed
(point-to-point and P-ring) traffic types.
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